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Importing the project bundle

Documents and the Document Manager
Adding codes to documents
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Importing the project bundle

Welcome

A alto

New Project

X

Import Project

Your Projects °
Search Q
[ Last used ~]

Show all projects

@ AtlasDemo Pl

1 Document
Last used: 10/01/2022

@ A1_ProjectBundle
18 Documents
Last used: 10/01/2022

@ AlTest (Snapshot 2022-1-4 13.25.34) (Snaps...
7 Documents, 14 Quotations, 12 Codes
Last used: 09/01/2022

@ AlTest (Snapshot 2022-1-4 13.25.34) (Snaps...
Empty Project
Last used: 09/01/2022

@ AlTest (Snapshot 2022-1-4 13.25.34)
Empty Project
Last used: 04/01/2022

@ TestProjectBundle
7 Documents
Last used: 04/01/2022

@ AlTest

7 Documents, 5 Quotations, 4 Codes
Last used: 04/01/2022

[ T =
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News

ATLAS.1i 22 is here

Read all about the new features here,

06.01.2022

Join the premium course on Inter-coder Agreement Analysis:
January 13, 2022

Discover and learn the methodclogical requirements for performing an
inter-coder agreement analysis.

04.01.2022

Importing Survey Data in ATLAS.ti 22

Import survey data from your favourite tool - Google Forms, Survey
Monkey, Qualtrics and many more

03.01.2022

Teamwork made easy - Begin your callaborative work with
ATl AC #i WAlah

Show more ...

Tutorials

@ ATLAS ti

What's New in ATLAS.ti 22

What's New in ATLAS.ti 22

YouTube video

Getting started (Windows)
YouTube playlist

Think hding childron

Resources

ATLAS ti 22 - QuickTour
Get Started with ATLAS i

ATLAS ti 22 — User Manual
Learn more about ATLAS ti

Sample Projects

®

Get to know ATLAS.ti with sample projects

Show more ...

Getting started (Mac)
YouTube playlist

Preparing Data (Windows)
‘YouTube playlist



Documents and the Document Manager

AtlasDemoPP - ATLAS £

[ Documents

& © Codes
New Edit | Navigator Documents Quotations Codes Memos Networks Links  Project
Entities~ | Comment - Project Explorer - = - Explorer »
New Project Navigator Managers
Explore v x
Search
4 53 AtlasD,

= (0)
[? Memos (0)

® Networks (0)

D Document Groups (0)
&> Code Groups (0)

[ Memo Groups (0)

@® Network Groups (0)
[) Multimedia Transcripts (1

AtlasDemoPP

The project has no comments.
Click to edit comment

Project Overview

2 Created by Markus Aalto on
[ Documents 1 10/01/2022
@ Last modified on 10/01/2022
O ET= o & Current user Markus Aalto
@ version 22.0.5.0
@ Quotations [+]
[? Memos 0
® Networks 0

Comment:

Nothing to display.

ATLAS i
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Documents and the Document Manager

Tab system:

Coding | Cluotation | Margin Entities | Explore & Analyze Document
Explore v X DacumentManager | @ D 1: DemoTranscript « |
Search Q,
4 (2 AtlasDemoPP K
b [ Documents (1)

<» Codes (0)

[7 Memaos (0)

& Metworks (0) Q: What is Lorem Ipsum?

0l Dacurnent Groups (0)

&> Code Groups (0) A: Lorem Ipsum is simply dummy text of the printing and typesetting industry. Lorem Ipsum has

[ Memo Groups (0 been the industry's standard dummy text ever since the 1500s, when an unknown printer took a
@® Network Groups (0) galley of type and scrambled it to make a type specimen book. It has survived not only five centu
O} Muktimedia Transcripts (i but also the leap into electronic typesetting, remaining essentially unchanged. It was popularise
the 1960s with the release of Letraset sheets containing Lorem Ipsum passages, and more recen
with desktop publishing software like Aldus PageMaker including versions of Lorem lpsum.

Q: Why do we use it?

Aalto University
School of Science
|



Adding codes to documents

1. Highlight text in a document

A!

Q: What is Lorem Ipsum?

A: Lorem lpsum is simply dummy text of the printing and typesetting industry. Lorem Ipsum has
been the industry's standard dummy text ever since the 1500s, when an unknown printer took a
galley of type and scrambled it to make a type specimen book. It has survived ppt only five centuries,
but also the leap into electronic typesetting, remaining essentially unchanged. It was popularised in
the 1960s with the release of Letraset sheets containing Lorem Ipsum passages, and more recently
with desktop publishing software like Aldus PageMaker including versions of Lorem Ipsum.

Q: Why do we use it?

A: It is a long established fact that a reader will be distracted by the readable content of a page when
looking at its layout. The point of using Lorem lpsum is that it has a more-or-less normal distribution

Ak latbmes ar Aanaacad fa arimes HMantant hars cantant hacra! aealibies i laal liba sasdabkla Caslick
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Adding codes to documents

2. Right click for coding options

Q: What is Lorem Ipsum?

A: Lorem lpsum is simply dummy text of the printing and typesetting industry. Lorem Ipsum has
been the industry’s standard dummy text ever since the 1500s, when an unknown printer took a
galley of type and scrambled it to make a type specimen book. It has survivegot only five centuries,
but also the leap into electronic typesetting, remaining essentially unchanged. It was p —_— T
the 1960s with the release of Letraset sheets containing Lorem Ipsum passages, and gfore re|] < | Apply Codes
with desktop publishing software like Aldus PageMaker including versions of Lore s | Code In Vivo

Q: Why do we use it? Quick Coding

A: It is a long established fact that a reader will be distracted by the readable content of a pa
looking at its layout. The point of using Lorem Ipsum is that it has a more-or-less normal dist] © | cate Link Source

Af lattare ar Aarnmacad fa ncina 'Cantant hara crantant hara' malkinag it laal lika rasdahkla Easl
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« Apply Codes: opens the
window for adding new

Apply Codes and applying existing
codes
ca | Code ln Vivo « Code In Vivo: adds the
_ _ selected text as a new
= » | Ouick Coding code

* Quick Coding: applies
the last code you used

A' Aalto University
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Code window

A: Lorem Ipsum is simply dummy text of the printing and typesetting industry. Lorem Ipsum has o = DemoCode
DemoCode2

been the industry's standard dummy text ever since the 1500s, when an unknown printer took a
galley of type and scrambled it to make a type specimen book. It has survivegfiot only five centuries,
but also the leap into electronic typesetting, remaining essentially unchanged. It was popularised in
the 1960s with the release of Letraset sheets containing Lorem Ipsum passages, and more recently
with desktop publishing software like Aldus PageMaker including versions of Lorem Ipsumb

Q: Why do we use it?

@ 1:4p 1in DemoTranscript

| All Codes H Applied Codes |

| Q

Comment: [

Zero or multiple groups selected

Aalto University
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Code manager

< Document Manager

R

(& D 1: DemeoTranscript [0 Code Manager ~

e e e

Search Entities

Name Grounded

| Density Groups

Created by Maodified by ‘ Created

[ Modified

o ¢ DemoCode
o » DemoCo...
o » DemoCo..

MNo code groups

Drag codes here to create a group

Learn mere about groups

Name

Markus Aalto  Markus Aalto
Markus Aalto  Markus Aalto
Markus Aalto  Markus Aalto

Grounded: how many times the code occurs

Group
Created by

10/01/2022 21.24
10/01/2022 21.28
10/01/2022 21.32

10/01/2022 21.24
10/01/2022 21.28
10/01/2022 21.32

Aalto University
School of Science



Code group manager

Add New Edit
Documents » Entities » | Comrnent

Memos Networks Links  Project
- - =  Explorer~

New Project Mavigator
Explore > X

Search Q,
4 (=] AtlasDemoPP

e AtlasDemoPP

[ Memos (0}
& Metworks (0)

The project has no comments.

Click to edit comment

de Groups (0)
Sl roups
B MNetwork Groups (0

[) Multimedia Transcripts { Project Overview

- Created by Markus Aalto on

1 Documents 1 10/01/2022
(® Last modified on 10/01/2022
& Codes 3 A Current user Markus Aalto
@ Version 22.0.5.0
@) Quotations 3
[? Memos 0
& Networks 0
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Code group manager

Manage Groups AtlasDemoPP - A

Code Groups

H Analyz :
<<> . <<> 4 @ E:[j Edit Comment @ a

+ _ £4 Edit Smart Group _
New MNew Smart | Duplicate Take Rename Delete | —_ Show in Search Excel
Group [Group~ Snapshot Open Code Manager | Network | theWeb~ | Export
New Manage Explore Report
plore | Codes v X @Codeﬁrouphlanager > X
Search Codes Q
Name | | Density|
© ¢» DemoCode 2 0
0 ¢» DemoCo.. 2 0
0 ¢» DemoCo.. 1 0
No code groups
Click on the New Group button in the Codes ribbon to add groups te your pr
Learn more about code groups
Codes in group: Codes not in group:
| Name| | Name ~
<» DemoCode
<» DemoCode2

> DemeCodel

Group creation is at the top
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Code group manager

j Search Code Groups

| Mame — ~ ‘ 5|ze| Created by Created Modified by | Modified

> DemoGroup 0 Markus Aalto  10/01/2022 2142 Markus Aalto  10/01/2022 21.42

Codes in group: /.-—\iodes not in group:

|N'A| ( \iName ~

| < DemoCode
| < DemoCode2
“ o | <> DemoCode3

V

Comment:

Add and remove codes from groups using the
arrows

Aalto University
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Merging codes

Analyze

Import 8 Ex

4 = AtlasDemoPP

<> © DemoCode {

<> © DemoCode2

Show Quotations
[ Memos (0)

& MNetworks (0]

|0} Document Groups
b &> Code Groups (1)

|[? Mema Groups (0)

® MNetwork Groups (0)

[ Multimedia Transcri

Show in Manager

Show in Metwork

=) | Edit Comment

Change Color 3
MNew Group

MNew Folder

MNew Folder from Selection

Create Smart Code

Set Global Filter

Comment:

Aalto University
School of Science
|

D B =] E [[) Documents
& e <> Codes
Add MNew Edit Mavigator el ] Documents Quotations Codes Memos Metworks Links  Project
Documents - Entities = | Comment = ue Project Explorer - - - - - Explorer~
Mew Project Mavigator Managers
Explore v X
Search Q

comments.

ent

#- Created by Markus Aalto on
1 10/01/2022

(® Last modified on 10/01/2022
2 A Current user Markus Aalto
0 version 22.0.5.0
3
0
0



Code report

Open Code Manager > Report

Manage Codes AtlasDemoPP - ATLAS.i

Import & Export Tools Help Search 8 Filter Tools View

EI:I Edit Comment 4 Change Color - [&ﬂ]
/ Edit Srnart Code 3¢ Merge Codes ) = =
Duplicate | Rename Delete | _ Showin | Word Word Qoncepts ||Report| Excel
Code(s) Code Open Group Manager | < > Split = Metwork | Cloud  List
Manage Explore &8¢ A
jer = X
wps Q| Search Entities
| MName Grounded | Density Groups Cre
3 [ o «» DemoCode 2 0 Mz
o ¢ DemoCo... 2 0 Mz
o < DemoCo... 1 0 Mz

' Aalto University
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Exporting and merging

« Exporting: File > Export > Project Bundle
* Merging: File > Merge > Merge Project Bundle



Intercoder Agreement Analysis

Search & Code Analyze Import & Export

) B¢
R )

Add Mew Edit Mavigator o _
Documents = Entities - | Comment - e Project Bxplorer
Mew Project Mavigator
Explore
Search

A @ AlTest (Snapshot 2022-1-4 13.25.34) (Snapshot 2022-1-4 14.02.59)
b [ Documents (7)

Import & Export Tools Help

rcurnent Disable Intercoder
ile Intercoder Mode || Agreement
sulaticn Reliability
X
17 90 T4 Mool 2 W 4 A 1A N OO

T|:| |:||5. H EIF'

o

-

w N

& o @ @& ¢
Documents Cuotations Codes Memos Metworks Links
Managers
v X
o}

AlTe

Open the Analyze tab after
merging projects

Enable Intercoder Mode
Click Intercoder Agreement to
open the tab

' Aalto University
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Intercoder Agreement Analysis

== Intercoder Agreement ~ X

2 Coders
{ Add Coder

Add Document

3. And finally, add codes as Semantic Domains

ntercoder Agreement ¥ x

= Int
2, Cod
{ x Lucy Trueng < z Markus A;

Add Codes
Search Codes
D11
| Name ~
< New Semantic Domain * — & aware of new VR tech
Add Code & blurry text
Add Semantic Domain [o] Comparisen to previous exp...~
B < cool
Add Document [0 < Experiment comments
[0 < helpful hands
m &% inctead wnihave tn nn rlnee

1. Add the coders you
want to compare

Add Coders

Search Users Q,
| Mame Fa |

[0 & ATLASH

& Lucy Truong

Bl & Markus Aalto

Add Coders

2. And the document

Add Documents

Search Documents Q
| D~ | Mame |Qu0ta...|
B @mD1 1 14

Aalto University
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Intercoder Agreement Analysis

FEmD 11
~ <> Semantic Domain: aware of new VR tech, blurry text, Comparisen to previous experience, cool <

< aware of new VR tech <
it | 1%« 177/ 6853 (26%)
il | OO/ 685300 %)
o blurry text >
H - 1 12+ 56/ 6853 (0.8%)
s 1 O« 06853 (0005
N nnnnariean fn o mens e e memnrimemen
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Thank you!
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